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About the Klocwork packages and components
The Klocwork Insight installation packages and components allow you to install only the components you need on a
specific machine.

Note: The Distributed Analysis package is covered separately in Installing the Distributed Analysis package

Server package components
DetailsComponent

A FLEXlm license manager (command-line name: license). You can also use
your organization's FLEXlm server. Default host: localhost Default port: 27000
plus 33133

License Server

An Apache Tomcat Web server (command-line name: klocwork). Provides
access to Klocwork Review, Klocwork Cahoots and Klocwork documentation.
Klocwork clients connect to the Klocwork Server for project information.

Klocwork Server

Note: Klocwork does not support using your own Apache Tomcat
server. You must use the Web server packaged with Klocwork.
Default host: localhost Default port: 8080 plus 8081 The Klocwork
Server component now contains the Klocwork Database. Default
host: localhost Default port: 3306

Integration build analysis tools:Klocwork build tools

» tools for managing Klocwork projects, analysis and access control (kwadmin
and kwbuildproject)

» tools to produce a build specification (kwinject, kwwrap, kwant,
kwcsprojparser)

» tools for running Klocwork integration build analysis (the analysis engines)
» tools for managing Klocwork projects and access control
» sample projects

The data location for the Klocwork Servers and applications, including the
project database tables, which are stored in MySQL and Lucene databases.

Klocwork projects_root directory

Note: The projects_root directory is not one of the components
you see listed in the installation wizard, but the wizard lets you
choose a location for it.
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Desktop analysis components
DetailsComponent

Command-line versions of the Klocwork developer tools
for C/C++ and Java, which allow software developers to

Klocwork command line

verify the quality of source code before they commit it to
source control. Also includes Klocwork Desktop, a GUI
alternative to running kwcheck.

Note: This component also includes the
Klocwork Extensibility API for writing
custom checkers.

The Klocwork desktop analysis plug-in for integration with
Microsoft Visual Studio. Supports Visual Studio versions
2005, 2008, 2010 and 2012.

Klocwork Desktop plug-in for Visual Studio

The Klocwork desktop analysis plug-in for Eclipse and
Eclipse-based IDEs.

Klocwork Desktop plug-in for Eclipse

The Klocwork desktop analysis plug-in for IntelliJ IDEA.Klocwork Desktop plug-in for IntelliJ IDEA

Note: Once deployed, users can download the desktop plug-in installers from the main page of the
Insight portal. Each binary has the following naming format:

kw-insight-IDE-installer.platform.exe

See Installing a desktop analysis plug-in for details on installing the desktop analysis plug-ins.
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Upgrading from a previous version
Insight provides a simple way to import your existing Klocwork Insight projects into a new projects_roots directory.
You can use the Klocwork Insight portal GUI to connect to your existing Klocwork server then choose which projects
you'd like to import. If you're a Klocwork Cahoots user, you can also connect to your existing Cahoots server to import
your Klocwork Cahoots code reviews to Insight. The GUI enables a quick and painless migration to the very latest
version of Klocwork Insight.

We realize that no two installations are the same, and depending on your installation, you may choose to migrate your
projects root directory in its entirety. This method is still supported. Both methods are described in detail in the sections
below.

Import your existing projects into a new projects root
Insight now includes a simple GUI that you can use to import projects from an existing projects_root to your new
Klocwork installation. This allows you to migrate your data on a project by project basis without using the command
line, and without the need to validate your database.

Before you decide to import your projects, make sure that your current installation supports this feature.

Note: This is the preferred upgrade
method.

Typically, this process involves the following steps:

» backing up your existing projects_root (just to be safe),
» installing the new Klocwork Insight Server (either on a new machine or using a different port number),
» starting the new server, opening the portal, and using the GUI to import existing projects to the new installation,

and
» after testing your new installation, uninstalling the existing server and projects_root.

Before you begin

The import process involves running your existing Insight installation (and projects_root) and your new Insight installation
(with clean projects_root) concurrently. Once you've installed the new server, you must import any projects from the
existing projects_root into the clean projects_root.

Remember that you cannot run two Klocwork servers on the same machine without specifying unique port numbers.
If you plan on installing the new Klocwork installation on the same machine, it's a good idea to stop and restart your
existing server using a different port number. This will allow you to maintain the existing port number for you new
installation.

Both the Klocwork and Database servers require fully qualified domain names or IP addresses assigned in order to
be accessible from the target server host during the import process. Don't use localhost.

Note: You must have local projects_root administrator access in order to perform the import
operation.

Supported upgrade paths to versions of Insight that support project import

You can import your projects from any version of 9.5 or 10.0 as well as the most recent service releases of 9.2 and
9.6 are supported. If you are upgrading from release 9.0 or 9.1, you need to follow the appropriate upgrade path to
upgrade to 9.2 SR3, or any of the versions described in the table below.

Find your current version in the chart below and follow the appropriate upgrade path. Once you've upgraded to the
correct version of Insight, you can import your existing projects from there. If you are upgrading from a release earlier
than 9.0, contact Customer Support for further instructions.
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Apply this service releaseIf you're using Insight version

9.2 SR39.2

any service release9.5

9.6 SR59.6

any service release10.0

Once you've upgraded to a supported service release or version, you can install the latest version of Klocwork Insight,
then use it to connect to your existing server to import your existing projects. Follow the steps described below to
import your projects.

Install the Insight Server package

Install the version 10.1 Server package. For instructions, see Installing Klocwork Insight on page 14 for more information.

Be sure to copy your license file to <projects_root>/licenses .

Note: See Customizing licensing for information on licensing
options.

Start the server

Once you've installed the new version of Insight, start the server being sure to specify a unique hostname and port
number.

You can specify the hostname and port number either at startup, or during the installation process. See, Starting the
Klocwork Servers for more information.

Log in to Klocwork Review

After starting the Klocwork servers, Klocwork Review is accessible from a browser using the URL of the Klocwork
server machine and the Klocwork server port chosen during the install (for example localhost:8080). By default, the
person who installed Klocwork Insight is set as the Klocwork administrator, and is given the Projects Root Administrator
role. Initially, the Basic Authentication access control method is used, so no password is needed to log in. For example,
if the user account used during the installation was ‘jsmith’, to log in to Review with the administrator role, use the
credentials:

username: jsmith
password: <empty>

For more details on security and authentication methods, see Security and permissions

Import your projects and server settings

With the new Klocwork server installed and the portal up and running, you can import server settings and projects
from your existing Insight installation.

When you import server settings from the existing source server, all global permission settings are imported along
with the permission settings for only those projects that exist on the destination server. In other words, if you import
Server A's settings to Server B, then you import a project from Server A to Server B, any permission settings that are
specific to project A will not be carried over to Server B. To carry forward project A's project-specific permission
settings, you must re-import the server settings after performing the import operation.

Important: In cases where a project contains custom settings, you must re-import your server settings
after performing a project import.

To import your existing projects:

1. In the Klocwork portal, click Insight and log in to the product using your project_root admin account.
2. Click the Projects tab.
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If this is your first time using the installation, click the Import settings or projects button.

If you've already created a project or imported a project, click the Import button.

3. In the Klocwork server connection dialog, specify the log in and connection information for your existing Insight
installation (the installation from which you want to import). Specify:

» the URL of the existing server, for example: http://server21:8082 ,
» your user name. Note: you must have projects_root administrator rights in order connect to the server and

import your projects,
» your password (if required).

4. Click Import server configuration to import the existing server's configuration settings. This includes authentication
configuration settings, permissions, custom metrics, reports definitions and e-mail subscription settings.

5. Click List Projects to see a list of projects in your existing projects_root.
6. In the Choose projects to import dialog, select the project(s) that you want to import to your new projects_root.
7. Click Import. The Import status dialog will display the status of the project import, while an import status message

will appear at the top of the Projects tab.

Any project that imported successfully will appear in your projects list.

Note: During the import process, while projects are actively being imported, issue information in
the Projects view may not accurately reflect the data in the source project. Information in the Projects
view will be updated as soon as the import operation has completed. Check the import status
indicator for progress information.

8. Click Import server configuration again to import any project-specific configuration settings. This is a mandatory
step, since any project-specific configuration settings will be lost if you do not re-import the server settings.

9. For each imported project, click Permissions and check that the permissions are correct for each project.

It is important to verify the permissions for each project since at import time, permissions are merged between source
server and destination server. You should repeat this process after each import operation, and you must be careful
to re-import the server settings for each source server that you import from.

Use the Web API to import your projects
You can use the Klocwork Web API to import your projects on the command line. The following example shows a curl
script to import a given project:

curl --data "action=import_project&user=myself&project=my_project&sourceURL=http://oldserver:8080&sourceAdmin=user&sourcePassword=pwd"
http://localhost.klocwork.com:8080/review/api

where:

» project is the name of the project you want to import,
» sourceURL is the URL of the existing, source Klocwork Server,
» sourceAdmin is the user id of the source Klocwork Server administrator (must have projects_root admin access),
» sourcePassword is the administrator's password.

To return a list of all projects in the source projects_root folder, run the following command:

curl --data "action=projects&user=myself&"
http://localhost.klocwork.com:8080/review/api

You can also use the Web API to import your server configuration settings:

curl --data "action=import_server_configuration&user=myself&sourceURL=http://oldserver:8080&sourceAdmin=user&sourcePassword=pwd"
http://localhost.klocwork.com:8080/review/api

Typically these operations are scripted using a language such as Python or Perl. See the Klocwork Insight Web API
cookbook for examples of scripted curl calls using Python.
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Import your code reviews

You can import your existing Klocwork Inspect or Klocwork Cahoots code reviews into your new projects root.

To import your existing Klocwork Inspect code reviews:

Note: Before importing code review data, you must have the equivalent project in your local projects
root. Importing code review data will overwrite any existing code review data in the current projects_root
folder.

1. In the Insight Product Portal, click Cahoots.
2. Click Settings, then in the left pane, click Import.
3. Click Import code reviews, then specify the URL of the source Klocwork server, the user ID of the Klocwork

administrator for the source projects root, and the password (if required).
4. Select the projects that you want to import, then click Import .

To import your existing Klocwork Cahoots code reviews:

Note: Klocwork Cahoots does not organize code reviews by project. When you import existing code
reviews from your Cahoots server, you must specify the code reviews by tag.

1. In the Insight Product Portal, click Cahoots.
2. Click Settings, then in the left pane, click Import.
3. Click Import code reviews, then specify the URL of the source Klocwork Cahoots server, the user ID of the

Klocwork administrator for the source projects root, and the password (if required).
4. Select the local project into which you want to import the code reviews.
5. In the left pane, select the tags that you want to import.
6. Click Assign to assign the tags to the selected project.
7. Click Import to import the code reviews.

Test your upgrade

Ensure that you can see your projects and builds in Klocwork Review.

If you installed a new license file, ensure that it was installed correctly by checking that the number of licenses is
correct.

Go live with your new installation

Once you're satisfied that your new installation is valid, and that your existing projects were imported correctly, it's
time to go live with your new installation.

If you've chosen a new and unique port number for your new installation, then you can go ahead and communicate
that information to your users.

If you'd like to reuse your existing port number (so that users don't have to update their local settings) then you'll need
to stop and restart all of your Klocwork servers, taking care to specify the existing server port number for your new
installation.

Upgrade all Desktop Analysis plug-ins

Ensure that all Klocwork plug-ins are upgraded to Insight 10.1.

Your users can reinstall their Klocwork Desktop Analysis plug-ins themselves by downloading the appropriate plug-ins
from the Klocwork portal once it is up and running. See Downloading and deploying the desktop analysis plug-ins on
page 24 for instructions on how to download and deploy the plug-ins to the server.

Before your first version 10.1 integration build analysis

New releases of Insight normally have changes to the checker configuration to keep up with current events and
respond to customer requests. These changes may mean that your checker configuration from the previous release
isn't the same in the new release.
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Make sure that you have the right checkers enabled to match your old configuration. See What's New for a list of
updated checkers, then make any changes to your checker configuration. After you're satisfied with your configuration,
perform your first version 10.1 integration build analysis on unmodified source code.

Note: If you've already run your first 10.1 analysis and you're missing some issues or status changes,
delete that build, reconfigure your checkers, and run a new analysis.

We recommend running your final pre-upgrade integration build analysis and your first version 10.1 analysis on identical
source code, and then comparing the two builds. This allows you to assess changes in the analysis engine. For details
on improved, added and removed checkers in this version, see What's New.

Migrate your projects_root
You can migrate your projects_root and configuration settings over to your new Insight installation by using the
kwservice --migrate command. Typically, this process involves:

» Stopping your server and backing up your existing projects root folder and configuration settings,
» installing the new Klocwork server package by specifying the existing projects root folder, server and port settings,
» re-validating your database and,
» testing your installation.

Note: Migration of your projects_root folder is only supported as part of the upgrade from Insight 10.0. If
you're upgrading from an earlier version of Insight, see Import your existing projects into a new projects
root.

See Migrate your projects_root directory for more information about migrating from an earlier release.

Before you begin

To reduce the amount of time required for migration, we strongly recommend that you delete unneeded projects
and failed builds before migration, as detailed in the procedure that follows.

We also recommend that you make a copy of your projects_root directory and migrate the copy. This way, users
can continue to use Klocwork Review, though they should be instructed not to make any changes, such as changing
an issue's status.

If you do not use the default server settings, you will need to specify your custom settings prior to beginning the
upgrade. Otherwise, during the installation these settings will revert back to the default settings. If you forget, you can
always go in and change the settings for each of your environments after you have completed upgrading.

To avoid losing issues, status changes or comments from the last release in your first release 10.1 analysis run, make
sure you read Before your first 10.1 integration build analysis.

Supported upgrade paths

You can only use the migrate utility to upgrade from the last version of the product. To upgrade from earlier versions
of the product, use the import method. See Import your existing projects into a new projects_root for more information.

Then follow this upgrade pathIf you're using Insight version

10.0 any release --> 10.1 GA or SR.x10.0

Interoperability between releases

Clients earlier than Klocwork Insight 10.1 cannot interoperate with a Klocwork Insight 10.1 Server. You must upgrade
both your Server and Desktop Analysis plug-in installations to Klocwork Insight 10.1.

Running two versions of the Klocwork Servers

If you will be running two sets of the Klocwork Servers, for example to test the Klocwork Insight 10.1 Servers while
users continue to access your existing servers, you must run them on different projects_root directories (and set the
ports appropriately).
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Prepare to upgrade

For details on starting and stopping the servers, see Starting the Klocwork Servers and Stopping the Klocwork Servers.

To prepare to upgrade:

1. For the projects_root you wish to migrate, run:

kwservice --projects-root <projects_root> check

2. Make note of what servers are running and what ports they are running on. After migration to the new version
of Klocwork Insight, the servers will be running on these ports.

3. Stop the servers.
4. To create a restore point, perform a complete backup of any projects_root directories you want to migrate. After

you upgrade Klocwork Insight, you cannot undo the upgrade. For information, see Backing up Klocwork data.
5. If you customized any configuration files (such as kwmysql.ini or kwfilter.conf), back up the

<server_install>/config directory.
6. Start the servers.
7. IMPORTANT: To reduce the time required to migrate your Klocwork data, Klocwork strongly recommends that

you:

» Delete any projects from the previous version that you do not need to migrate. See kwadmin delete-project.
» Delete any failed project builds from the previous version. You cannot resume a build that failed in a previous

release after migrating the project as described in this article. However, you may be able to load the build
from tables. See kwadmin delete-build.

8. Stop the servers.
9. (Optional) To create a second restore point, back up the projects_root directories you have prepared for migration.
10. Store the existing Klocwork license in a safe place.
11. To prevent confusion, delete the old Klocwork logs from <projects_root>/logs.

Install the Insight Server package

Install the version 10.1 Server package. For instructions, see Installing Klocwork Insight on page 14 for more information.

Validate your database (mandatory)

dbvalidate is a tool that checks the consistency of data in your database. It works on Insight versions 8.2 and later.
Running this tool is mandatory, so that any errors in your database can be corrected before you migrate.

Note: The Database Server from your old installation must be running to validate the
database.

Run the following command:

java -jar <10.1_server_install>/class/dbvalidate.jar --projects-root <projects_root>

where

» <10.1_server_install> is your new installation directory
» <projects_root> specifies the location of the old projects root you want to migrate

Example

java -jar C:/Klocwork/Server 10.1/class/dbvalidate.jar --projects-root
C:\Klocwork\projects_root
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dbvalidate will report any errors between the "validation started" and "validation finished" lines:

Wed Jun 01 07:53:58 CDT 2011 kw_central database (version: 95) validation started
<detected errors appear here>
Wed Jun 01 07:54:28 CDT 2011 Database validation finished.

» If Errors are displayed, contact Klocwork Customer Support, so that we can correct the error prior to migration.
» If no errors are displayed, your database was successfully validated.

Put your new license in the correct directory

If you received a new license file from Customer Support, copy it to <projects_root>/licenses.

Note: See Customizing licensing for information on licensing
options.

Migrate your Klocwork data

To migrate a projects_root, run the following command from <Klocwork_10.1_Server_install>/bin:

kwservice --projects-root <old_projects_root> start --migrate

If the projects_root migrates successfully, the Klocwork Servers start on the port numbers picked up from the migrated
projects_root.

Notes:

» If you will be running the Klocwork Servers as Windows services, after starting the servers with the --migrate
option, stop the servers with kwservice --projects-root <migrated_projects_root> stop. Then
start the Insight 10.1 services in Windows Services Administration.

» You can manage the Klocwork servers remotely on Unix with SSH, or on Windows with Windows Services
administration. Otherwise, you must issue the start, restart and stop commands locally.

» The above command converts all external configuration files in the projects_root to UTF-8. As of Klocwork Insight
8.1, all external configuration files must be UTF-8 encoded if they contain multibyte characters (for example,
Japanese). External configuration files are those listed in Configuration files you can edit.

If you customized configuration or metrics files

» If you modified the MySQL configuration file located at <old_Klocwork_install>/config/kwmysql.ini

Make the same changes to kwmysql.ini in the new installation.

Note: The following fields are no longer supported with the version of MySQL used with Insight
9.2 and later. If your previous kwmysql.ini file contains these fields, do not copy these lines
to the new file:

skip-bdb

myisam_max_extra_sort_file_size

Important: Do not copy your customized configuration files into the new Insight installation. Instead,
make the same customizations to the newly installed configuration files.

» If you modified the compiler mapping file located at <old_Klocwork_install>/config/kwfilter.conf

Make the same changes to kwfilter.conf in the new installation.

Important: Do not copy your customized configuration files into the new Insight installation. Instead,
make the same customizations to the newly installed configuration files.
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» The following files are obsolete as of Insight 9.5 and do not need to be migrated:

» the compiler configuration file (kwcc_config.xml)

See kwinject error - Compiler can't be configured for more information.

» compiler filter files (<compiler_name>_filter.xml)

You may need to contact Customer Support to replace your *_filter.xml file with a Python script. See
Adding an unsupported C/C++ compiler for details.

» If you added custom metrics reports to Klocwork Review, you need to edit the custom metrics report
configuration file (metrics.xml). Prior to Klocwork Insight 9.0, the metrics.xml file was located at:

<server_install>/webapps/review/reporting/config

» As of Klocwork Insight 9.0, the metrics.xml file is located at:

<projects root>/config

Notes

» As of Klocwork Insight 9.0, the metrics.xml file applies to a projects_root directory, not to an entire Klocwork
installation. Therefore, if you have multiple projects_root directories, you will need to copy your customized
metrics.xml file to each of your projects_roots.

» As of Klocwork Insight 9.0, you need to restart the Klocwork Server after customizing the metrics.xml file.

Test your upgrade

Ensure that you can see your projects and builds in Klocwork Review.

If you installed a new license file, ensure that it was installed correctly by checking that the number of licenses is
correct.

Upgrade all Desktop Analysis plug-ins

Ensure that all Klocwork plug-ins are upgraded to Insight 10.1.

Your users can reinstall their Klocwork Desktop Analysis plug-ins themselves by downloading the appropriate plug-ins
from the Klocwork portal once it is up and running. See Downloading and deploying the desktop analysis plug-ins on
page 24 for instructions on how to download and deploy the plug-ins to the server.

Repeat upgrade steps on other projects_root directories

To migrate another projects_root, carry out the steps in this chapter again (except for installing Klocwork).

Summary of upgrade steps for second or later projects_root directory:

1. Prepare to upgrade.
2. Run:

kwservice --projects-root <projects_root> start --migrate

3. Re-create any compiler configuration files you had customized.
4. If you added custom metrics reports to Klocwork Review, edit the custom metrics report configuration file

(metrics.xml).
5. Test your upgrade.
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Before your first version 10.1 integration build analysis

New releases of Insight normally have changes to the checker configuration to keep up with current events and
respond to customer requests. These changes may mean that your checker configuration from the previous release
isn't the same in the new release.

Make sure that you have the right checkers enabled to match your old configuration. See What's New for a list of
updated checkers, then make any changes to your checker configuration. After you're satisfied with your configuration,
perform your first version 10.1 integration build analysis on unmodified source code.

Note: If you've already run your first 10.1 analysis and you're missing some issues or status changes,
delete that build, reconfigure your checkers, and run a new analysis.

We recommend running your final pre-upgrade integration build analysis and your first version 10.1 analysis on identical
source code, and then comparing the two builds. This allows you to assess changes in the analysis engine. For details
on improved, added and removed checkers in this version, see What's New.
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Installing Klocwork Insight
Follow the steps described below to install the Klocwork Server and Desktop Analysis plug-ins. For help, see
Troubleshooting your installation on page 34 below.

Installing the Klocwork Server package on Windows
This page provides instructions for installing the Klocwork Server package using the installation wizard. For instructions
on unattended installation of both the Klocwork Server and desktop analysis plugins, see Unattended installation on
Windows.

Your users can install the desktop analysis plug-ins from the product portal ("pull" installation) or, if your organization
is set up for it, you can install the clients for your users in an unattended ("push") installation through a Software
Management System (SMS) or similar system.

Before you begin

Upgrading? See Upgrading from a previous version.

Where do I get the software?

Download the packages from Klocwork support. Typically, only one or two users in an organization have access to
Klocwork Developer Network. If you don't have access, you can register for a new account.

You need a license. See Getting a license if you don't already have one.

Running two versions of the Klocwork Servers

If you will be running two sets of the Klocwork Servers, for example to test the Klocwork Insight 10.1 Servers while
users continue to access your existing servers, you must run them on different projects_root directories (and set the
ports appropriately).

Required permissions

» Administrator access is required to install all Windows packages, whether using the installation wizard or unattended
installation.

» You must have administrator access to install the Klocwork Server.
» You must have administrator permissions to start the Klocwork Servers (and to run the Klocwork Servers as

Windows Services).
» For Windows Server 2008, you must use the 'Run As Administrator' option in order to launch any Klocwork tools

which access a projects_root that is located on a root directory.

Installation using the Windows installation wizard

Run the Klocwork Server installation wizard, following the prompts. Note the following:

» During installation, one or more Visual C++ Runtime redistributable packages may be installed on your computer.
Depending on your operating system, a reboot may be required at the end of the installation.

» The installation package will automatically detect whether you have a 32-bit or 64-bit operating system and will
install the appropriate version of Java.

» If your system locale is Japanese, the installation package runs in Japanese. Otherwise, it runs in English.
» You can specify server information during installation in the Klocwork Servers configuration screen to override

the default settings. The defaults for the License Server are localhost and 27000. The default port for the Klocwork
Server is 8080. See Viewing and changing Klocwork server settings for more information on ports.

» For information on the Use secure server connection (HTTPS) checkbox, see Using a secure Klocwork Server
connection.

» You'll be asked where you want to create the projects_root directory, which is the data location for the Klocwork
Servers and applications. It contains Klocwork Server settings and information about integration projects and
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build analysis runs. It also stores the Klocwork license file. The default location is
<server_install>\projects_root.

Caution: Do not install the Server package and the projects_root in the Program Files directory.
Default security settings for Windows 7 and Windows Server 2008 restrict writing to files in the
Program Files directory.

» During installation, you specify whether you want to use the locally installed License Server (Local) or connect to
a remote License Server (Remote). Local, the default option, requires you to browse to your license file. If you
select Remote, you must specify the host name and port number for your License Server.

» If you specify a new projects_root location during installation, you have the option of starting the Klocwork
Servers as Windows services automatically following installation. This option is available on the Set up Klocwork
Servers dialog of the Server package installer. If you do not select this option, you need to start the servers
manually following installation.

Note on the Path environment variable

On Windows, the Klocwork bin directory is automatically added to your Path environment variable as follows:

Value usedEnvironment variable modifiedInstallation package

<server_install>\binSystem PathServer

<desktop_analysis_tool_install>\binSystem PathDesktop Analysis Tools

Log files for Windows installation

An installation log file is saved to the Temp directory of Local Settings whenever one of the Klocwork installation
packages is started on Windows. For example, on Windows 7, the installation log file is saved to
\Users\<user>\AppData\Local\Temp.

These log files are named Klocwork<release_number>-<package>.log . For example, the installation log file
for the Klocwork 10.1 Server package is named Klocwork10.1-Server.log.

A logs directory is also created in the root Klocwork installation directory during installation. For the Server installer,
for example, the log files in this directory store kwservice output when the servers are first started and the projects_root
directory is initialized.

Start the servers

To start the servers, use Windows Services Administration or kwservice start:

kwservice --projects-root <projects_root> start

where<projects_root> is the projects_root directory you specified during installation

Example

kwservice --projects-root C:\klocwork\projects_root start

Log in to Klocwork Review

After starting the Klocwork servers, Klocwork Review is accessible from a browser using the URL of the Klocwork
server machine and the Klocwork server port chosen during the install (for example localhost:8080). By default, the
person who installed Klocwork Insight is set as the Klocwork administrator, and is given the Projects Root Administrator
role. Initially, the Basic Authentication access control method is used, so no password is needed to log in. For example,
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if the user account used during the installation was ‘jsmith’, to log in to Review with the administrator role, use the
credentials:

username: jsmith
password: <empty>

For more details on security and authentication methods, see Security and permissions

Installing the Klocwork Server package on Windows -- Upgrade only
This page provides instructions for installing the Server package if you are upgrading.

IMPORTANT: This is not the starting point for upgrading. Make sure you start with Upgrading from a previous version.

Before you begin

Where do I get the software?

Download the packages from Klocwork support. Typically, only one or two users in an organization have access to
Klocwork Developer Network. If you don't have access, you can register for a new account.

Required permissions

» Administrator access is required to install all Windows packages, whether using the installation wizard or unattended
installation.

» You must have administrator access to install the Klocwork Server.
» You must have administrator permissions to start the Klocwork Servers (and to run the Klocwork Servers as

Windows Services).
» For Windows Server 2008, you must use the 'Run As Administrator' option in order to launch any Klocwork tools

which access a projects_root that is located on a root directory.

Run the installation wizard

Run the Klocwork Server installation wizard, following the prompts. Note the following:

» The installation package will automatically detect whether you have a 32-bit or 64-bit operating system and will
install the appropriate version of Java.

» If your system locale is Japanese, the installation package runs in Japanese. Otherwise, it runs in English.
» Caution: Do not install the Server package and the projects_root in the Program Files directory. Default security

settings for Windows 7 and Windows Server 2008 restrict writing to files in the Program Files directory.
» For information on the Use secure server connection (HTTPS) checkbox, see Using a secure Klocwork Server

connection.
» When prompted for the location of the projects_root directory, specify the old projects_root directory that you

want to migrate.
» You do not need to set host names and port numbers for the Klocwork Servers during installation. This information

will be picked up from your old projects_root directory when it is migrated.
» Do not select the option to start the Klocwork Servers as Windows services automatically. You will start the servers

in a later step.
» The Klocwork bin directory (<server_install>\bin) is automatically added to your System Path environment

variable.

Log files

An installation log file is saved to the Temp directory of Local Settings whenever one of the Klocwork installation
packages is started on Windows. For example, on Windows 7, the installation log file is saved to
\Users\<user>\AppData\Local\Temp.

These log files are named Klocwork<release_number>-<package>.log . For example, the installation log file
for the Klocwork 10.1 Server package is named Klocwork10.1-Server.log.
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A logs directory is also created in the root Klocwork installation directory during installation. For the Server installer,
for example, the log files in this directory store kwservice output when the servers are first started and the projects_root
directory is initialized.

Installing the Klocwork Server package on Unix
This page provides instructions for installing the Klocwork Server package using the installer.

Before you begin

Upgrading? See Upgrading from a previous version.

Where do I get the software?

Download the packages from Klocwork support. Typically, only one or two users in an organization have access to
Klocwork Developer Network. If you don't have access, you can register for a new account.

You need a license. See Get a license if you don't already have one.

Running two versions of the Klocwork Servers

If you will be running two sets of the Klocwork Servers, for example to test the Klocwork Insight 10.1 Servers while
users continue to access your existing servers, you must run them on different projects_root directories.

Check the system requirements

Refer to the System requirements for a list of required packages and dependencies.

Installation notes

» Linux only: There are separate installation packages for 32-bit and 64-bit Java. Make sure you select the one
that matches your operating system.

» ulimit -n must be 2048 in order to run the Klocwork Server.
» Ensure that the downloaded .sh file is executable. Use the chmod command to set the appropriate

permissions:chmod 755 <kw-installer.sh>
» To control permissions when you are installing Klocwork, change the value of umask.
» Install Klocwork software as a non-root user.
» Ensure that the path in which you install the product is the same path from which users invoke the product. For

example, the local path to the installation might be /local/tools/klocwork, but users on other machines
have to use the NFS path /opt/tools/klocwork to invoke the product. Therefore, to ensure that users can
invoke the product, use the /opt/tools/klocwork path during installation.

» For some Linux installations, if you want to run the Klocwork Server, you may be required to install additional
third-party libraries. For example: libaio1, libaio, or libaio.x86_64.

Note: Due to MySQL limitations, the projects_root directory should not be located on NFS. It has a special
file locking implementation which is not fully supported by MySQL. See also the warning in the MySQL
documentation.

Running the installation package

Run the following command:

kw-server-installer.10.1.x.x.<platform>.sh [options] <install_directory> [<component
...>]

where

» <platform> is solaris, linux or aix
» [<options>] are any of the options listed in Command-line options for the Server package.
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» <install_directory> specifies the directory in which you want to install Klocwork. Do not specify a subdirectory of
the projects_root directory. Note that if the chosen directory is not empty, you will not be able to continue with
the installation.

» [<component ...>] is any of the arguments from Arguments for Server components. Separate multiple components
with spaces. If you do not specify one or more components, the entire package will be installed. You can also
see a list of arguments for the various components with the --list option.

Command-line options for the Server package

DescriptionShort nameName

Agree to license terms and do not display license
agreement.

-a--agree

Specify the port number that you will use to run the
Database Server. Default: 3306. This option is equivalent
to specifying the port number with kwservice.

--database-port <port_number>

Print debug information--debug

Install without integrity checks-f--force

Display this help and exit-h--help

Specify the port number that you will use to run the
Klocwork Server. Default: 8080. This option is equivalent
to specifying the port number with kwservice.

--klocwork-port <port_number>

Specify that the License Server will be run locally, but on
a non-default port. Default: 27000. This option is equivalent
to specifying the port number with kwservice.

--license-port <port_number>

Specify a remote License Server host. The host argument
is required; the port argument is optional. Default:

--license-server <host>[:<port>]

localhost:27000. This option is equivalent to specifying the
host and port with kwservice. See also Using your
organization's FLEXlm server.

List available features (components)-l--list

Specify the complete path to a non-default projects_root
directory. Default:

-p--projects-root <directory>

<install_directory>/projects_root. The
directory you specify must meet one of the following
conditions:

» it does not yet exist
» it is empty
» it is a valid projects_root directory created previously

Do not specify the same directory as the root
Klocwork installation directory you have specified. Do
not install Klocwork in a subdirectory of the
projects_root directory.

IMPORTANT: If you are upgrading, specify the old
projects_root directory that you want to migrate.

use a secure Klocwork server connection (HTTPS)--use-ssl

display the version of Klocwork software and exit-v--version
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Arguments for Server components

...enter the argument...To install this Server component (feature)...

LicenseServerLicense Server

KlocworkServerKlocwork Server

BuildToolsAdministration and analysis management tools

Add Klocwork to your PATH

On Unix, we recommend adding <klocwork_install>/bin to your PATH. Otherwise, you need to execute
commands from <klocwork_install>/bin.

Copy the license file

Copy your license file to the following location:

<projects_root>/licenses

The license file must have the extension .lic.

Note: See Customizing licensing for licensing options such as using your organization's license
server.

Start the servers

Start the servers with kwservice start:

kwservice --projects-root <projects_root> start

where <projects_root> is the projects_root directory you specified during installation

Example

kwservice --projects-root /space/klocwork/projects_root start

You see messages indicating that the servers have been started, showing the server host name and port number and
the path to the projects_root. For example:

Using projects root: /space/klocwork/projects_root Local Host is: serverxyz.com
[13.1.1.142] Starting License Server [started on serverxyz.com:27000] (projects
root is /space/klocwork/projects_root) Starting Database Server [started on
serverxyz.com:3306] (projects root is /space/klocwork/projects_root) Starting
Klocwork Server [started on serverxyz.com:8080] (projects root is
/space/klocwork/projects_root)

Important:  If you create a script to start the Klocwork servers automatically, do not name your script
'klocwork' as it will interfere with existing processes.

Log in to Klocwork Review

After starting the Klocwork servers, Klocwork Review is accessible from a browser using the URL of the Klocwork
server machine and the Klocwork server port chosen during the install (for example localhost:8080). By default, the
person who installed Klocwork Insight is set as the Klocwork administrator, and is given the Projects Root Administrator
role. Initially, the Basic Authentication access control method is used, so no password is needed to log in. For example,
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if the user account used during the installation was ‘jsmith’, to log in to Review with the administrator role, use the
credentials:

username: jsmith
password: <empty>

For more details on security and authentication methods, see Security and permissions

Installing the Klocwork Server package on Unix -- Upgrade only
This page provides instructions for installing the Server package if you are upgrading.

Important:  This is not the starting point for upgrading. Make sure you start with Upgrading from a previous
version.

Before you begin

Where do I get the software?

Download the packages from Klocwork support. Typically, only one or two users in an organization have access to
Klocwork Developer Network. If you don't have access, you can register for a new account.

Installation notes

» Linux only: There are separate installation packages for 32-bit and 64-bit Java. Make sure you select the one
that matches your operating system.

» ulimit —n must be 2048 in order to run the Klocwork Server.
» Ensure that the downloaded .sh file is executable. Use the chmod command to set the appropriate

permissions:chmod 755 <kw-installer.sh>
» To control permissions when you are installing Klocwork, change the value of umask.
» Install Klocwork software as a non-root user.
» Ensure that the path in which you install the product is the same path from which users invoke the product. For

example, the local path to the installation might be /local/tools/klocwork, but users on other machines
have to use the NFS path /opt/tools/klocwork to invoke the product. Therefore, to ensure that users can
invoke the product, use the /opt/tools/klocwork path during installation.

Note: Due to MySQL limitations, the projects_root directory should not be located on NFS. It has a special
file locking implementation which is not fully supported by MySQL. See also the warning in the MySQL
documentation.

Run the installation package

Run the following command:

kw-server-installer-10.1.x.x.<platform>.sh -p <projects_root> [options]
<install_directory> [component ...]

where

» <platform> is solaris, linux oraix
» <projects_root> is the location of the old projects_root directory that you want to migrate
» [<options>] are any of the options listed in Command-line options for the Server package

Note: You do not need to set host names and port numbers for the Klocwork Servers during
installation. This information will be picked up from your old projects_root directory when it is
migrated.
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» <install_directory> specifies the directory in which you want to install Klocwork. Do not specify a subdirectory of
the projects_root directory. Note that if the chosen directory is not empty, you will not be able to continue with
the installation.

» [<component ...>] is any of the arguments from Arguments for Server components. Separate multiple components
with spaces. If you do not specify one or more components, the entire package will be installed. You can also
see a list of arguments for the various components with the --list option. Note that an asterisk in the returned
output means the component is already installed.

Example

kw-server-installer-10.1.0.0.linux.sh -p /space/old_projects_root /opt/klocwork

Command-line options for the Server package

DescriptionShort nameName

Agree to license terms and do not display license agreement.-a--agree

Specify the port number that you will use to run the Database
Server. Default: 3306. This option is equivalent to specifying the
port number with kwservice.

--database-port <port_number>

Print debug information--debug

Install without integrity checks-f--force

Display this help and exit-h--help

Specify the port number that you will use to run the Klocwork
Server. Default: 8080. This option is equivalent to specifying the
port number with kwservice.

--klocwork-port <port_number>

Specify that the License Server will be run locally, but on a
non-default port. Default: 27000. This option is equivalent to
specifying the port number with kwservice.

--license-port <port_number>

Specify a remote License Server host. The host argument is
required; the port argument is optional. Default: localhost:27000.

--license-server <host>[:<port>]

This option is equivalent to specifying the host and port with
kwservice. See also Using your organization's FLEXlm server.

List available features (components)-l--list

Specify the complete path to a non-default projects_root
directory. Default:

-p--projects-root <directory>

<install_directory>/projects_root. The directory
you specify must meet one of the following conditions:

» it does not yet exist
» it is empty
» it is a valid projects_root directory created previously Do

not specify the same directory as the root Klocwork
installation directory you have specified. Do not install
Klocwork in a subdirectory of the projects_root directory.

IMPORTANT: If you are upgrading, specify the old projects_root
directory that you want to migrate.

use a secure Klocwork server connection (HTTPS)--use-ssl

display the version of Klocwork software and exit-v--version
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Arguments for Server components

...enter the argument...To install this Server component (feature)...

LicenseServerLicense Server

KlocworkServerKlocwork Server

BuildToolsAdministration and analysis management tools

Add Klocwork to your PATH

On Unix, we recommend adding <klocwork_install>/bin to your PATH. Otherwise, you need to execute
commands from <klocwork_install>/bin.

Installing the Klocwork Server package on Mac
This page provides instructions for installing the Klocwork Server package using the installer.

Before you begin

Upgrading? See  Upgrading from a previous version.

Where do I get the software?

Download the packages from Klocwork support. Typically, only one or two users in an organization have access to
Klocwork Developer Network. If you don't have access, you can register for a new account.

You need a license. See Getting a license if you don't already have one.

Prerequisites

» JVM versions: You must install JVM 1.6 on your machine before installing the Klocwork Server package or a
desktop analysis plug-in. If you have a previous JVM version installed and you try to install the Server, you will
see the error message, "Version of Java is too old". Apple supplies their own version of Java. Use the Software
Update feature on your Mac.

» Access level: When installing the Mac packages, you must have administrator access.
» If your organization uses GCC, make sure the correct version of the compiler is in your PATH before you run the

installation program. Including the GCC compiler in your PATH automatically creates default links to standard
GCC libraries and defines for all the projects you create. Note that any user can override these defaults for a
particular project or build by not including the standard libraries and defines. If your organization does not use
GCC, do not include it in your PATH when you run the installation program.

Default settings and installation directories

» The Klocwork Server and desktop analysis packages are installed in the /Applications/ and
/Library/Frameworks/ directories.

» Access command-line tools using the symbolic links in /usr/local/kw/.
» The projects_root directory installs to /Users/Shared/Klocwork/projects_root/ by default.
» The Klocwork Servers are set to localhost, running on the default ports.

You can override server settings and specify where the projects_root is created during installation.

Running the installation package

Copy the Klocwork Server installation package to your desktop and run it, following the prompts. Please note the
following:

» The Server Settings screen is where you can adjust:

» the location of the projects_root directory
» ports for the Klocwork and Database Servers
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» During installation, you specify whether you want to use the locally installed License Server (Local) or connect to
a remote License Server (Remote). Local, the default option, requires you to browse to your license file. If you
select Remote, you must specify the host name and port number for your License Server.

Troubleshooting

Check the installation log from the Console (Applications > Utilities) or var/log/install.log.

Start the servers

Start the servers with kwservice start:

kwservice --projects-root <projects_root> start

where<projects_root> is the projects_root directory you specified during installation

Example

kwservice --projects-root /Users/Shared/Klocwork/projects_root start

You see messages indicating that the servers have been started, showing the server host name and port number and
the path to the projects_root. For example:

Using projects root: /space/klocwork/projects_root Local Host is: serverxyz.com
[13.1.1.142] Starting License Server [started on serverxyz.com:27000] (projects root
is /space/klocwork/projects_root) Starting Database Server [started on
serverxyz.com:3306] (projects root is /space/klocwork/projects_root) Starting Klocwork
Server [started on serverxyz.com:8080] (projects root is /space/klocwork/projects_root)

Log in to Klocwork Review

After starting the Klocwork servers, Klocwork Review is accessible from a browser using the URL of the Klocwork
server machine and the Klocwork server port chosen during the install (for example localhost:8080). By default, the
person who installed Klocwork Insight is set as the Klocwork administrator, and is given the Projects Root Administrator
role. Initially, the Basic Authentication access control method is used, so no password is needed to log in. For example,
if the user account used during the installation was ‘jsmith’, to log in to Review with the administrator role, use the
credentials:

username: jsmith
password: <empty>

For more details on security and authentication methods, see Security and permissions

Installing the Klocwork Server package on Mac -- Upgrade only
This page provides instructions for installing the Server package if you are upgrading.

Important:  This is not the starting point for upgrading. Make sure you start with Upgrading from a previous
version.

Running the installation package

Copy the Server installation package to your desktop and run it, following the prompts. Please note the following:

» All components of the Klocwork Server package are installed. You can't specify which components you want to
install.

» On the Server Settings screen, when prompted for the location of the projects_root, specify the old projects_root
directory that you want to migrate.
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» You do not need to set host names and port numbers for the Klocwork Servers during installation. This information
will be picked up from your old projects_root directory when it is migrated.

Installation directories

» The Server package is installed in the /Applications/ and /Library/Frameworks/ directories.
» Access command-line tools using the symbolic links in /usr/local/kw/.

Troubleshooting

Check the installation log from the Console (Applications > Utilities) or var/log/install.log.

Downloading and deploying the desktop analysis plug-ins
The desktop analysis tools refer to the desktop analysis plug-ins and the Klocwork Command Line tools.

As Klocwork Administrator, you can download the desktop analysis tools from
http://developer.klocwork.com/support/downloads (see Desktop Tools Packages), unzip them, and place them within
the clients directory of the Klocwork Server installation. This will allow your users to download a desktop analysis
tool directly from the portal. Once downloaded, your users can easily install a desktop analysis plug-in on their own.

Depending on your corporate IT policies, you may decide to install the Klocwork desktop analysis tools yourself, as
part of a controlled rollout. If this is the case, follow the steps below to download the Klocwork Desktop tools, then
see the installation instructions for details on how to install the plug-ins on your user's desktops.

The Klocwork Desktop Tools packages are organized by platform, where each archive contains a plug-in for IntelliJ
IDEA, Visual Studio (Windows-only), and the Command Line tools package. The Eclipse update site archive is platform
independent.

PlatformPackage

Windowskw-insight-desktop-tools.10.1.0.xxxx.windows.zip

Mackw-insight-desktop-tools.10.1.0.xxxx.mac.zip

Linuxkw-insight-desktop-tools.10.1.0.xxxx.linux.zip

Solariskw-insight-desktop-tools.10.1.0.xxxx.solaris.zip

Note: the xxxx portion of the path indicates the minor build
number.

To deploy the Klocwork Desktop tools:

1. Download the applicable Klocwork Desktop tools package from the download site at developer.klocwork.com.

You'll need to log in to the site using your Klocwork Developer Network user ID and password. If you do not
currently have a Klocwork Developer Network user ID and password, you'll need to register as a new user.

2. Once downloaded, unzip the Desktop Tools package archive into the <server_install_path>\clients
directory, where <server_install_path> is the location of your Klocwork Server installation on Windows.

» On Linux, the folder is located at<server_install_path>/clients
» On Mac, the folder is located at /usr/local/kw/server/clients

or/Library/Frameworks/KlocworkServer.framework/Versions/10.1/clients

Note: This directory contains a single file called clients.json. Do not delete this
file.

24 | Installing Klocwork Insight | Klocwork Insight

http://developer.klocwork.com/support/downloads
http://developer.klocwork.com/support/downloads


1. Refresh the portal and verify that the Downloads list appears on the right hand side of the portal. The Downloads
list contains links to the desktop analysis plug-ins. Your users can download and install the desktop analysis tools
directly from here.

2. Communicate the deployment to your users, either by sending them a link to the portal and to the installation
instructions or by sending an internal email that describes how users can download and install the plug-ins.

Installing a desktop analysis plug-in
After you (as Klocwork Administrator) have installed and started the Klocwork Servers, and downloaded and deployed
the desktop analysis plug-ins to the server installation, your users can access the product portal and download and
install a desktop analysis plug-in. If your users prefer to work on the command line or wish to do a combination of
both, they may want to install the command line tools.

Note: The Downloads section will not appear in the portal until the Klocwork Administrator has deployed
the plug-ins. See Downloading and deploying the desktop analysis plug-ins for more information.

For more information about deploying the desktop analysis plug-ins see, Downloading and deploying the desktop
analysis plug-ins.

To install a plug-in, open the product on the machine where you've installed Insight. For example, go to:

http://server01:8080/portal/Portal.html

Install your plug-in

As a desktop analysis user, once you've downloaded the installation package from the server, you must run the
installer. On Windows and Mac, an installation wizard is provided to guide you through the installation process.

Before you begin

» You can override the default settings for the Klocwork Servers during installation. The defaults for the License
Server are localhost and 27000. The default port for the Klocwork Server is 8080.

» On Windows: Change Current Destination Directory screen: Avoid installing the package in the Program Files
directory on Windows Vista, Windows Server 2008 and Windows 7 machines. Windows User Access Control
(UAC) restricts writing to the Program Files directory.

» Klocwork Servers configuration screen: Specify the Klocwork Server information provided by your Klocwork
administrator. Select Use secure server connection (HTTPS) if a secure Klocwork Server connection has been
configured.

» JVM version: You must install JVM 1.6 Update 45 or later or JVM 1.7 update 25 or later on your machine before
installing the desktop analysis plug-in.

» Make sure that you have the appropriate administrator access before installing the desktop plugin.
» On Unix:

» To control permissions when you are installing Klocwork Insight, change the value of umask.
» To change the permissions on an existing installation, use chmod.
» Install Klocwork software as a non-root user.
» Linux only: There are separate installation packages for 32-bit and 64-bit Java. Make sure you select the

one that matches your operating system.

On Windows and Mac

For each of these plug-ins on Windows and Mac, simply download the package and run the installation wizard. The
installation wizard will guide you through the rest of the process.

On Mac

» Files are installed in the following location:/Library/Frameworks/
» Access command-line tools using the symbolic links in /usr/local/kw/.

On Unix
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You can install the packages using the following command:

kw-insight-<plug-in>-installer.sh [options] <install_directory>

Where

» <plug-in> is the name of the plug-in you want to install. For example, 'cmd' or 'idea'.
» [options] are any command line options you may want to specify. In most cases, just specify '-a' here to indicate

that you agree to the terms of the Klocwork license. Use --h to get help on what available command line options
exist.

» <install_directory> specifies the directory where the Insight plug-in will be installed

Add the bin directory to your PATH

We recommend adding the <command_line_tools_install>/bin directory to your PATH environment variable.
Procedures in the documentation assume that you have added the bin directory to your PATH.

Command-line options for the desktop analysis plugin package on Unix

DescriptionShort nameName

agree to license terms and do not display license agreement-a--agree

install without integrity checks-f--force

display this help and exit-h--help

specify the Klocwork Server host name and port number.
Default: localhost:8080.

--klocwork-server <host>[:<port>]

specify the License Server host name and port number.
Default: localhost:27000

--license-server <host>[:<port>]

use a secure Klocwork Server connection--use-ssl

display the version of Klocwork software and exit-v--version

print the debug information--debug

Example: Installing the Command Line Tools package on Linux

kw-cmd-installer.linux64.sh -a /home/jlee/klocwork

where

» -a means that you agree to the terms of the Klocwork license
» /home/jlee/klocwork specifies where Klocwork Insight will be installed

Example: Installing Klocwork Desktop Plug-in for IntelliJ IDEA on Linux

kw-idea-installer.linux64.sh -a "/opt/klocwork/user 10.1" --klocwork-server
server1:8084

where

» -a means that you agree to the terms of the Klocwork license
» "/opt/klocwork/user 10.1" is the path to the Klocwork user install directory
» --klocwork-server specifies the name and port of the Klocwork server

Installing the Klocwork plug-in from the Eclipse update site

Prerequisites:
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» The Downloads section (which contains the Eclipse update site link) will not appear in the portal until the Klocwork
Administrator has deployed the plug-ins. See Downloading and deploying the desktop analysis plug-ins for more
information.

To install the Klocwork Desktop Analysis plug-in for Eclipse, simply follow the steps below.

1. In the Insight product portal, under Downloads, click Eclipse update site.

2. Copy the URL specific to your platform.

3. Open Eclipse.

Important: The Klocwork plug-in for Eclipse C/C++ requires the Microsoft Visual C++ 2008 Redistributable
Package(32-bit) and the Microsoft Visual C++ 2012 Redistributable Package(32-bit), which you need to
install manually. You can download them both by accessing the Insight product portal and selecting
Eclipse update site under Downloads.

Follow the instructions according to the version of Eclipse you're using:

Eclipse 3.5 and greaterEclipse 3.4

4. In Eclipse, go to Help > Install New Software.4. In Eclipse, go to Help > Software Updates.

Wind River Workbench: Select the Advanced Device Development perspective (the button near the upper right) to
access Help > Software Updates.

5. In the Install dialog, paste the URL into the Work with: field.

6. Now click the box next to Klocwork Tools, click Next and the wizard will guide you through the rest of the installation
process.

7. When you are prompted to restart Eclipse, click Yes.

Troubleshooting

» Package Load Failure occurs in Visual Studio after I install patch
» Error reading setup initialization file during installation
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Running a custom installation for new or upgraded IDEs
If, after you installed Klocwork Insight, you upgraded your IDE, you must uninstall the previous version of the plug-in.
For uninstallation information, see Uninstalling Klocwork Insight.

After uninstalling, either:

» re-run the Klocwork desktop analysis plug-in installer, or
» install from the Eclipse plugin from the update site in your new version of Eclipse

If you're using Klocwork Desktop Command Line or Klocwork Desktop, you don't have to do anything further.

Upgrade steps are provided below, by IDE plug-in.

Visual Studio
In Windows, go to Control Panel > Programs and Features. Right-click Klocwork for Visual Studio and select Change
to modify your settings.

Deselect features you don't want installed.

Eclipse
Regardless of the Eclipse version you upgraded to, simply install the Eclipse plugin from the update site. See Install
the Klocwork plug-in from the Eclipse update site.

IntelliJ IDEA
If you installed the upgraded version of IntelliJ IDEA in the same directory, you don't need to do anything further.

If you installed IDEA to a different location:

» Windows:

Re-run the Klocwork desktop analysis for IntelliJ iDEA installer.

During installation, Klocwork Insight automatically detects your IntelliJ IDEA directory and installs the plug-in
directory to that location. If more than one IDEA installation directory is detected, you have to browse to the
preferred location.

» Linux:

Run the following command:

kw-idea-installer.linux64.sh -a <user_install>

where

» <user_install> is the directory where you want to install Klocwork. Note that if the chosen directory is not
empty, you will not be able to continue with the installation.

Example:

kw-idea-installer.linux64.sh -a /home/jlee/Klocwork
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After you install
The following topics describe post-installation activities including testing your installation, running an unattended
installation, installing the distributed analysis package, and troubleshooting.

Installing the Distributed Analysis package
The Distributed Analysis components are available as a separate Klocwork installation package (for example, on Linux,
the package is kw-dist-build-installer.10.x.x.xx.linux.sh).

Installing on Unix

To install the complete Klocwork Distributed Analysis package on Unix:

1. Download the Klocwork Distributed Analysis installation package for your operating system to a temporary
directory.

2. Ensure that the downloaded .sh file is executable. Use the chmod command to set the appropriate permissions.
Enter:

chmod 755 <executable-name>

Note: Install Klocwork software as a non-root
user.

3. Run the executable with the options and arguments you want.

<kw-dist-analysis-installer> -a -i <install_directory>

where:

<kw-dist-analysis-installer> is the name of the installation executable

-a indicates that you accept the license agreement

<install_directory> is the absolute path to the location in which you want to install the Distributed Analysis
package

Installing on Windows

On Windows, you can use the installation wizard or perform an unattended installation.

To install the Klocwork Distributed Analysis package on Windows, you must have administrator permissions for the
machine you want to install on.

Installing Klocwork with the installation wizard

To install the Klocwork Insight Distributed Analysis package or its components on a local machine:

1. Download the Klocwork Distributed Analysis package for Windows to a temporary directory.
2. Run the installation executable.

The graphical user interface initializes and prepares.

The Welcome screen of the wizard appears.

3. Click Next.

The License Agreement screen appears.

4. Review the license agreement, and, if you agree, click "I accept the terms of the license agreement".
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5. Click Next.

The "Destination Directory" screen appears.

The default destination directory is the local drive with the most available space. For example:

D:\Klocwork\Distributed Analysis 10.1\

6. Click Next to accept the default folder or click Change... to install Klocwork in a different location.

If you click Change..., the Change Current Destination Folder screen appears. Browse to the folder where you
want to install Klocwork.

Important: Avoid installing the package in the Program Files directory on Windows Vista, Windows
Server 2008 and Windows 7 machines. Windows User Access Control (UAC) restricts writing to
the Program Files directory.

7. Click OK.
8. Click Next.

The Setup Type screen appears.

By default, the Complete button is selected.

9. To install the entire Klocwork Distributed Analysis package on one machine, leave the Complete button selected
and go to step 11.

To select one component to install on this machine, click Custom and click Next.

The Custom Setup screen appears, showing two choices.

Note: In the Windows installation wizard, the term "feature" means
"component".

If there is a component you do not want to install on this machine, click the icon of the component and click
This feature will not be available. Any components you do not disable will be installed. Click off Klocwork
Distributed Analysis Server or Klocwork Distributed Analysis Agent, depending on which component you
do not wish to install.

Important: Ensure that you choose a location with enough disk space. See System requirements.
To see how much disk space is available on the machine, click Space.

10. Click Next.

The Ready to Install the Program screen appears.

11. To review or change any of your installation settings, click Back. To continue the installation with the settings
you have, click Install.

A progress bar appears while Klocwork installs.

The Setup Wizard Completed screen appears.

12. Click Finish.

Running an unattended installation on Windows

To run an unattended Windows installation of the Distributed Analysis package, enter the following command:

<kw-dist-build-installer> /S/v"/qn [ADDLOCAL=<component_code>]
INSTALLDIR=<install_directory> /lv* <log_file>"

where:

» <kw-dist-build-installer> is the name of the Windows Distributed Analysis installation executable
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» ADDLOCAL=<component_code> is optional and allows you to install only the Server or the Agent component
of the package

» <component_code> is either DistributedAnalysisServer orDistributedAnalysisAgent
» <install_directory> is the absolute path to the directory in which you want to install
» /lv* <log_file> allows you to log installation errors to file (recommended). The directory you specify must already

exist. Use the absolute path to the log file.

Note: Surround any value that contains spaces with escaped quotation marks
(\").

Example:

kw-dist-build-installer.10.1.0.0.windows.exe /S /v"/qn
INSTALLDIR=\"C:\Klocwork\10.1.0.0\Distributed Analysis\" <br/>/lvx*
C:\Klocwork\dist_analysis.log"

Log files for Windows installation

An installation log file is saved to %USERPROFILE%\Local Settings\Temp whenever one of the Klocwork
installation packages is started on Windows.

These log files are named Klocwork<release-number>-<package>.log . For example, the installation log file
for the Klocwork 10.1 Server package is named Klocwork10.1-Server.log.

A logs directory is also created in the root Klocwork installation directory during installation on Windows. For the Server
installer, for example, the log files in this directory store kwservice output when the servers are first started and the
projects_root directory is initialized.

If you need to troubleshoot your installation, check these logs.

Unattended installation on Windows
To run an unattended installation of Klocwork Insight, enter the following command:

start /WAIT <installer.exe> /w /S [/L<langid>] /v"/qn INSTALLDIR=<install_directory>
/log <install_log> PROPERTY=VALUE PROPERTY1=VALUE1..."

where:

» <installer.exe> is the name of the installation package you want to use, for example,
kw-server-installer.10.1.0.0.windows.exe

» /w parameter will cause the parent process to wait for the installation process. See the InstallShield help library
for more information on this.

Note: The %errorlevel% system variable can be used to check for installation
success.

» /L<langid> allows you to change the default language for the installation package. By default, if your system locale
is Japanese, the installation package will run in Japanese. Otherwise, it will run in English. To specify Japanese,
use /L1041.

» /v passes subsequent parameters directly to the MSI engine. The entire string after /v must be surrounded by
quotation marks.

» /qn runs the installer in unattended mode
» <install_directory> is the absolute path to the directory in which you want to install Klocwork Insight. The default

is the root directory of the local drive with the most available space. %LOCAL_DRIVE%\Klocwork\<package>,
where <package> can be Server or one of the desktop packages. Note that if the chosen directory is not empty,
you will not be able to continue with the installation.

» PROPERTY=VALUE is any of the Allowable PROPERTY=VALUE pairs for unattended installation
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Note: Surround any value that contains spaces with escaped quotation marks
(\").

Example

start /WAIT kw-server-installer.10.1.0.0.windows.exe /w /S /v"/qn
INSTALLDIR=\"D:\Klocwork\Server 10.1\" /log C:\server.log"

Installing a desktop analysis tool

You can install the desktop analysis tools using unattended installation, however you must first download the desktop
tools package from http://developer.klocwork.com/support/downloads (see Desktop Tools Packages) and unzip them
into a folder on your local machine. The desktop tools package contains installation binaries for each of the desktop
tools, organized by platform. For more information see, Downloading and deploying the desktop analysis plug-ins.

Once unzipped and placed into a directory on your local computer, run the unattended installation from the
command-line, specifying the file name of the installer for the desktop tool that you want to install. In the following
example, the IntelliJ IDEA plug-in is installed into a custom directory.

Example

start /WAIT kw-insight-idea-installer.windows.exe /w /S /v"/qn
INSTALLDIR=\"C:\kw\idea_plugin\" /log C:\idea_install.log"

Installing specific components in unattended mode

To install one or more specific Klocwork Insight components (for example, to install the database server) in an unattended
installation, include ADDLOCAL=<component_arguments> in your command line, where <component_arguments> is
one or more arguments from the following tables. Multiple arguments must be separated by commas.

...enter the argument...To install this Server component (feature)...

LicenseServerLicense Server

KlocworkServerKlocwork Server

BuildToolsAdministration and analysis management tools

Allowable PROPERTY=VALUE pairs for unattended installation

Server package

DescriptionPROPERTY=VALUE

Installs specific components only. See tables in previous
section for allowable values for this property.

ADDLOCAL=<component_list>

Install into the directory you specify. Default: current
working directory. Note that if the chosen directory is not
empty, you will not be able to continue with the installation.

INSTALLDIR=<install_directory>

Set up a projects_root directory in the directory you
specify. The default is

PROJECTS_ROOT=<projects_root_directory>

<Server_install>/projects_root. Specify the
complete path.

Important: If you are upgrading, specify
the old projects_root directory that you
want to migrate.

Specify License Server host name. Default: localhostLICENSE_HOST=<host_name>
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DescriptionPROPERTY=VALUE

Specify License Server port number. Default: 27000LICENSE_PORT=<port_number>

Specify Database Server host name. Default: localhostMYSQL_HOST=<host_name>

Specify Database Server port number. Default: 3306MYSQL_PORT=<port_number>

Specify Klocwork Server host name. Default: localhostKWSERVER_HOST=<host_name>

Specify Klocwork Server port number. Default: 8080KWSERVER_PORT=<port_number>

To use a secure Klocwork Server connection, set this value
to 1. Default: 0

USE_SSL=1

Note: The Server Installer also supports the ALLUSERS property. For details, see this MSDN
article.

Desktop plugins

DescriptionName

Installs specific components only. See tables in previous section for
allowable values for this property.

ADDLOCAL=<component_arguments>

Suppress creation of desktop shortcuts. Default: 1 (create shortcuts)CREATE_SHORTCUTS=\"\"

The directory where IntelliJ IDEA is installedIDEAINSTALLDIR= <directory>

Install into the directory you specify. Default: current working directory.
Note that if the chosen directory is not empty, you will not be able to
continue with the installation.

INSTALLDIR=<directory>

Use License Server running at <host_name>LICENSE_HOST=<host_name>

Use License Server running at <port_number>LICENSE_PORT=<port_number>

Use Klocwork Server running at <host_name>KWSERVER_HOST=<host_name>

Use Klocwork Server running at <port_number>KWSERVER_PORT=<port_number>

To use a secure Klocwork Server connection, set this value to 1. Default:
0

USE_SSL=1

Testing your installation
To test your Klocwork installation, you can either use the sample project 'demosthenes', or create and analyze your
own sample project.

Log in to Klocwork Review

After starting the Klocwork servers, Klocwork Review is accessible from a browser using the URL of the Klocwork
server machine and the Klocwork server port chosen during the install (for example localhost:8080). By default, the
person who installed Klocwork Insight is set as the Klocwork administrator, and is given the Projects Root Administrator
role. Initially, the Basic Authentication access control method is used, so no password is needed to log in. For example,
if the user account used during the installation was ‘jsmith’, to log in to Review with the administrator role, use the
credentials:

username: jsmith
password: <empty>

For more details on security and authentication methods, see Security and permissions
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Using demosthenes

In <Klocwork_install>\samples, you can find the Demosthenes sample project (a sample C/C++ project).

This directory contains a sample project and a readme file that shows you how to set up some sample analyses you
can use to explore or demonstrate Klocwork.

Note: To successfully build a sample project on Unix you should have GNU make, GCC and
bash.

Create and analyze a sample project

To test your Server package installation, you can create and analyze a sample project and then view the results of
your analysis in Klocwork Review:

» C/C++ integration build analysis - Cheat sheet
» Java integration build analysis - Cheat sheet
» C-sharp integration build analysis - Cheat sheet

Troubleshooting your installation
Need a hand with your installation? Did you have trouble installing the product? This section describes basic installation
issues and provides troubleshooting information.

Repairing a Windows installation of Klocwork Insight

If files in the Klocwork installation were accidentally damaged or deleted, you can repair the installation.

You may discover that your Klocwork installation is damaged, for example, if you are attempting to uninstall Klocwork
and see the error message "Fatal error: Cannot uninstall".

If this occurs, click OK in the error message dialog to cancel the uninstallation, perform the following repair procedure,
and then run the uninstallation procedure again.

To repair a Klocwork installation on Windows:

1. In the Start menu, click Control Panel > Add or Remove Programs .

The Add or Remove Programs dialog appears.

2. Select the Klocwork package you want to repair, and select Click here for support information.

The Support Info dialog for the selected Klocwork package appears.

3. Click Repair.

The installation is restored to a clean state.

Unable to start the Database Server because the path to the socket file is too long

If the path to the socket file (including separators and the name of the socket file) is greater than 107 characters, you
will be unable to start the Klocwork Database Server. The database log will indicate that this is the problem.

The socket file is located in the following directory:

<projects_root>/locks

To remedy this situation, move your projects to another projects_root with a path length of less than 68-72 characters,
depending on the length of the Database Server port number (which can be 1 to 5 characters).

For help moving a projects_root, see Moving or creating additional projects_root directories.

34 | After you install | Klocwork Insight



Unable to start Klocwork Servers following Windows installation

If you see one of the following messages after installing the Klocwork Server package on Windows:

» Error 1920. Service Klocwork 10.1 Server (Klocwork 10.1 Server) failed to start.
Verify that you have sufficient privileges to start system services.

» Service Klocwork 10.1 License Server failed to start. See installation log for
more details.

An earlier version of the Klocwork Server and/or Klocwork License Server may be running on the port that you specified
during installation of Insight 10.1. It is not possible to run two versions of a server on the same port.

You need to set a different port number for the 10.1 Klocwork Server and/or 10.1 Klocwork License Server with kwservice
set-service-property, and then start the servers.

Database connection error
Important: Due to MySQL limitations, the projects_root directory should not be located on NFS. It has a
special file locking implementation which is not fully supported by MySQL. See also the warning in the
MySQL documentation.

If you see the following error:

Error occurred while connecting to database: Database connection to <database> refused: Communications link failure
due to underlying exception

Check the host name in the error message. If the host name is not a fully qualified host name that includes the domain
(for example, server1.klocwork.com), you need to set the fully qualified domain name for the Database Server.

To do this:

1. Stop the Database Server:

kwservice --projects-root <projects_root> stop database

2. Run the following command:

kwservice --projects-root <projects_root> set-service-property database host
<fully-qualified-host-name>

For example:

kwservice --projects-root C:\Klocwork\projects_root set-service-property
database host server1.klocwork.com

3. Start the Database Server:

kwservice --projects-root <projects_root> start database

Package Load Failure occurs in Visual Studio after I install patch

You can either:

» uninstall the patch and install the last full version of the Visual Studio plug-in installer, or
» from the <VS_user_install>\inforceVSNET directory, run the following command:

regsvr32 IfPkgVS2005.dll
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What to communicate to the team
Your team of developers, managers, build engineers(s) and administrator(s) need to know the following:

» the URL of the Klocwork Server, so that managers and developers can access Klocwork Review and Klocwork
Cahoots, and install their own desktop analysis plug-ins

» that the URL of the Klocwork Server with "/documentation" added to it will give them all of the Klocwork online
documentation

» the location of the projects_root directory (Klocwork administrators only)
» the host and port of the License Server
» who has permission to start and stop the Klocwork Servers, under what user ID, and, for Windows, whether the

servers must be managed as Windows Services

If anyone else needs to access the database, for example, to do backups, and you have locked the database with a
password, give the person the password. See Setting a password for the Klocwork database for more information.
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Uninstalling Klocwork Insight
Before you uninstall

If you will be modifying or uninstalling a Server package or connected desktop installation, you must stop the Klocwork
Servers first. See Stopping the Klocwork Servers.

If you are uninstalling the Server package, in addition to stopping the servers, you should also make a backup copy
of your projects_root directory and any configuration files you modified, such as kwfilter.conf). For Unix and
Windows, compiler configuration files are located in <server_install>/config; for Mac they are located at
/Library/Frameworks/KlocworkServer.framework/<version>/config. For more information about
backing up data, see Backing up Klocwork data.

While the Windows version of the Klocwork Server package won't uninstall the projects_root directory or configuration
files, it's a good idea to make a backup of these directories to be on the safe side, particularly if you're uninstalling a
version previous to 7.7. For Unix systems, there is no automated uninstall, so make sure you back up your projects_root
and any other data files you want to keep and store them outside your Server installation directory. Then you can
delete the Server installation directory.

See also Repairing a Windows installation of Klocwork Insight.

Viewing installed components or modifying your installation on Windows

Use the procedure below if you want to remove one or more Klocwork components, or if you need to check what
components are currently installed. For example, if you need to uninstall Klocwork before installing a new version, you
should check what components are currently installed before uninstalling, so that you can install the same components
for the new version.

To view installed components or partially uninstall Klocwork:

1. In the Start menu, go to Control Panel > Add or Remove Programs .

Windows 7: From the Control Panel window, underPrograms, select Uninstall a program.

2. Scroll to and click the Server or desktop plug-in you want information on.
3. To find information about patches, make sure the Show updates checkbox is selected at the top of the Add or

Remove Programs panel.

Windows 7: Click View installed updates in the upper right.

The installed patches will be displayed under the Klocwork installation package entry.

4. Click Change.

Windows 7: Right-click the Klocwork installation package and select Change.

The Welcome screen for the Modification wizard appears.

5. Click Next.

The Program Maintenance panel appears.

6. Select Modify and click Next.
7. The Custom Setup screen appears. Click through it to see what components (features) are installed.

Note: This symbol indicates a component that is

installed:

8. If you are simply viewing installed components:
9. Record which components are installed.
10. Click Cancel.
11. Click Yes when asked if you are sure.
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12. Click Finish.
13. If you want to uninstall certain components, or install components you did not previously install:
14. For the components you want to uninstall, click This feature will not be available.

For the components you want to install, clickThis feature, and all subfeatures, will be installed on local hard
drive.

15. Click Next.

The Ready to Modify the Program screen appears.

16. Click Install.

The features you selected will be modified.

17. Click Finish.

Uninstalling Klocwork from a Windows machine

To remove a Klocwork software package:

1. From the Start menu, click All Programs > Klocwork Insight 10.1.
2. Select the uninstaller for the component that you want to uninstall.

Uninstalling in unattended mode on Windows

To run uninstallation in unattended mode from a Windows machine, enter the following command:

<installer.exe> /S /v"/qn REMOVE=ALL"

where<installer.exe> is the package you want to uninstall

An uninstallation log file will be saved to %USERPROFILE%\Local Settings\Temp. The log file is named
Klocwork<release-number>-<package>.log. For example, the uninstallation log file for the Klocwork 10.1
Server package is named Klocwork10.1-Server.log.

Uninstalling on Unix
Viewing installed components on a Unix machine

If you are upgrading to a new version of Klocwork, check what components are currently installed before uninstalling,
so that you can install the same components from the new version.

To list installed components (features), run the following command:

kwupdate [option ...] --list

See kwupdate for the full list of options.

To uninstall on Unix, simply delete the Server package and/or desktop plug-in package installation directory.

Uninstalling on Mac
To uninstall, delete the following directories:

/Applications/Klocwork Server 10.1

/Applications/Klocwork User 10.1

/Library/Frameworks/Klocwork*.framework

/usr/local/kw
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Uninstalling the plug-in from Eclipse and IntelliJ IDEA
Eclipse

To uninstall the Klocwork plug-in from Eclipse:

Eclipse 3.5 and 3.6Eclipse 3.4

1. From the Help menu, chooseHelp > About Eclipse"1. From the Help menu, choose Help > Software
Updates > Manage Configuration. 2. Click Installation Details.

2. The Product Configuration dialog appears. 3. Select the Klocwork plug-in from the list and click
Uninstall.3. Expand the items in the navigation pane until you

see the Klocwork feature.
4. Right-click the Klocwork feature and choose

Uninstall, and click Yes to confirm that you want to
disable this feature.

When you're prompted to restart Eclipse, click Yes.

Once Eclipse restarts, the Klocwork buttons and menu items are no longer present. If you haven't uninstalled the
Klocwork desktop analysis plug-in for Eclipse, your Klocwork projects remain in their storage location.

IntelliJ IDEA

1. Go to File > Settings.
2. Under IDE Settings, click Plugins.
3. Right-click Klocwork for Java in IntelliJ IDEA and select Uninstall.
4. Close IntelliJ IDEA.
5. Restart IntelliJ IDEA to confirm the removal by ensuring that the Klocwork button has been removed.

Note: You must restart IntelliJ IDEA after uninstallation, before you install a new version of
Insight.
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